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Getting Started with Zoom
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What is Zoom and When to Use it?
Zoom is one of several online video conferencing programs that provides software for:

e  Online sessions for up to 100 people
e  Webinars for up to 1000 people

There are many other programmes for video conferencing either one to one or small groups: (FaceTime,
Messenger, Skype, WhatsApp etc) or larger trainings or recordings: (Microsoft Teams, Cisco WebEx, Click
Meeting, Adobe Connect, Big Blue Button etc.) More are developing. Each has its strengths and
weaknesses. Zoom became popular in the 2020 Lockdown because of its price and its functionality.

Zoom has the following advantages:
e |tallows up to 100 participants (for a small fee can be increased). o zoom
e Afree version allows 40min meetings for 3+ and unlimited 1-1.
e The Pro version is reasonably priced and allows longer meetings with more capacity.
e The Host has control of the attendees.
e [|tincludes the ability to share any files etc. on your computer and have small group discussions.

There have been some security concerns which Zoom continually addresses. With normal internet
precautions and careful distributing of meeting details there should be no problems. Zoom has been used
for coffee mornings, interactive services, home groups, bible studies, PCC meetings, live streaming etc.

Note Zoom is constantly upgrading, and this booklet quickly becomes dated. Newer versions may be
available on the Diocesan website.

Image from: https://pixabay.com/illustrations/video-conference-online-home-office-5167472/
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Obtaining Zoom - Free Licence or Pro Licence?

A free licence is useful for all. The following outlines the additional benefits of a Pro Licence (currently
£11.90 per month or £119.90 for an annual licence):

Free Licence Pro Licence

Cost Free Monthly charge

Number of people who | 100

can attend:

100 (+ at additional cost)

40mins for 3 or more people. | 30 hours
24 hours for 2 people (but

everyone can log back in)

Maximum length of
meeting

The facilitator can control participants
adding, deleting, and making them co-hosts

Controlling other users | -

Recordings can be stored in a Zoom cloud for
easy viewing by others.

Recordings Must be saved on your own

computer.

Live Streaming - Can be live streamed to Facebook

Dial-Up Attendance - People can join on a landline.

Polling - Online polls can be created for feedback

The main benefit is the length of sessions. Regular Sunday worship or zoom meetings with more than 10
people, really need a Pro licence. If you are using it with one-to-one meetings, services are less than 40
minutes, or small groups happy to log in again after 40 mins then the free program will be sufficient.

To purchase or get the free licence go to https://zoom.us/pricing.

If you decide you need a second licence because you regularly want two meetings at the same time, then it
is easiest to buy a separate licence and share log in details. Alternatively, you can buy a second licence on
your account. In which case you will need to add a second user in your account: Under Admin> User
Management > Users. This user will need a different email address to log in on the account and can then
set up additional meetings.

© & https://zoom.us/pricing 80% o ¢ | Q. Adobe connect - [\

& Hermes Webmail Serv... [! Suggested Sites @ Web Slice Gallery

L —
200m SIe R S BN

SOLUTIONS ~ PLANS & PRICING CONTACT SALES JOIN AMEETING HOST A MEETING ~ SIGN IN

Zoom Meeting Plans for Your Business Zoom for Edixcation | Zoor for Téleheath | Zoor for Developers

Basic

Personal Meeting

Free

Sign Up, It's Free
Host up to 100 participants

Unlimited 1 to 1 meetings

40 mins limit on group meetings

Pro

Great for Small Teams
£11.99 imormost o
Purchase up to 9 hosts per account

P

All Basic features +

Includes 100 participants
Need more participants? e

Meeting duration limit is 24 hrs

Business
Small & Med Businesses
£15.99 /mormost o

0

Buy Now

All Pro features +

Includes 300 participants
Need more participants? )

Dedicated phone support

Enterprise

Large Enterprise-Ready

£15.99 jmormost o

1

Contact Sales

All Business features +

Enterprise includes 500 participants
Enterprise Plus includes 1,000
participants

Unlimited Cloud Storage

User management e Admin dashboard e Dedicsted Ciistomer SHecess
Unlimited number of meetings Manager
Ticket Support Admin feature controls ) Vanity URL e Estohive i Raviaws ®
Video Conferencing Features . .
Reporting e Option for on-premise o Bundle discounts on Webinars and
HD video deployment ———
Custom Personal Meeting ID Managed domains e
HD voice
Assign scheduler e
Active speaker view Single sign-on (i}
1GB of MP4 or M4A cloud e
Full screen and gallery view recording Company branding [ ]
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To obtain a free licence follow the online instructions. Click on the link that arrives by email to activate the
account. You will be asked for a password and account name (this is the name that will appear on your
SR : ——— - == Photo, so make it meaningful, e.g., avoid "ipad" etc.).
Finally, you have the option to open a trial meeting to test
your audio and video or go straight to your settings.

Welcome to Zoom
With a pro licence, after paying for the licence you then go
through a similar process.

ST Once you have created a zoom account it can be accessed
St e i online through your internet browser and/or an app on

— your desktop, phone, or tablet for easy access.
Sign In
If you are setting up a group/church account then use a corporate name (e.g.,
‘ All Saints) and unique password. You do not need a licence for everyone
— (expensive!), simply share the log in details with selected church members.
L s ] : .
PR Accessing your online account

Your online account gives you access to the Zoom Settings and full control of
your account. Go to https://www.zoom.us/signin and enter your registered

-|a|[»

email address and password.

Z OOI l . SOLUTIONS ~ PLANS & PRICING CONTACT SALES EDULE A MEETING JOIN A MEETING HOST A MEETING™= d’

PERSONAL

Meetings Recently Deleted Get Training

Upcoming Previous Personal Room  Meeting Templates

Webinars & to Schedule a Meeting
Hecorcings Tue, Mar 16
Settings
11:30 AM - 04:30 PM Zoom Basic Leading Training Elizabeth
Meeting ID: 851 7689 2650
ADMIN
> User Management Thu, Mar 18
> Room Management ;
09:00 PM - 10:00 PM My Meeting
NSt aaeeent Meeting ID: 58 7341
Fri, Mar 19
11:30 AM - 01:30 PM Zoom Advanced Training - Elizabeth
Attend Live Training Meeting ID: 890 7320 8574

v
Profile allows you to edit your profile, password,

add a picture for when video is off, etc. This menu provides a quick way to

Meetings lets you schedule future meetings, schedule a meeting, join a meeting or
create invitations, and start meetings. host a meeting immediately.

Recordings lets you access recordings of meeting

you have made. The final square (which will have your

Settings lets you alter settings that will apply to picture if you have set it in profile) holds
every meeting you run (see below) the sign out button

Admin has further settings for Pro Licences

BW Leading Zoom Handbook 2021v2.doc 4 11/03/2021
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Downloading the desktop program/app

This is optional but strongly advised. It provides a
handy, easy way to start a Zoom session and keep up
to date. Download the programme from:
https://zoom.us/support/download. The download

should happen automatically. Once completed, find
zoominstaller.exe in your downloads folder or use the
install link provided in your web browser. Once
installed the blue zoom icon will appear on your
desktop. Click on it. You will be asked whether you

want to join a meeting (i.e., someone else's meeting with the name and
password they send you) or sign in with your email and password.

Downloading the App for phone and tablet

From your Apple or Google Store, search for the free Zoom Cloud
Meetings App. Download and install it. With the App you can manually
join someone else's meeting with the ID and password sent to you or you

can Sign In and start and run your own Zoom sessions.

Layout of App and desktop program

200Mm

O
(]

3 Chat

Meetings  Contacts

22:48

08 June 2020

No upcoming meetings today

B Q_ Search &

Sign In
[ @D o
< Today
ZOOM Cloud
Meetings
@ t
4.6 % %k k& 1 4+

Top Menu:

mme gives the most frequent actions.

Chat: allows you to see saved chats from

previous meetings.

Meetings: lists your scheduled meetings and
allows you to start them or copy the invite.

New Meeting — lets you
start a meeting now.

Schedule — lets you set up a
meeting for a later time.

Join — lets you join someone
else's meeting.

Share Screen is for specially
configured meeting rooms
and not normally relevant.

Settings allows you to
change some settings
(these can also be

changed in a meeting

from video settings) — To

access the full range of
settings you will need to
go to your online
account through your
internet browser.

po

Elizabeth Harper BASIC
eli***@bathwells.anglican.org »«

Q. Search

Add a Personal Note

© Settings

® Available

© Away

© Do not disturb

My Profile

Try Top Features

Help >
Check for Updates

Switch to Portrait View

Switch Account

Sign Out

Contacts: lists any
contacts already
stored.

The Profile/ picture
button: includes a
drop-down menu
where you can
update your profile
and get new
updates. Zoom is
frequently updated,
and updates should
be checked at least
monthly.

Actions related to your computer, such as updating, have to be done through this app. Other actions
relating to your account, need to be done online through your online account login.

BW Leading Zoom Handbook 2021v2.doc 5
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Setting up your first meeting.

To create your first meeting, with the desktop programme/ app, choose either
"new meeting" to immediately start a meeting or choose "schedule a meeting"
for later. By scheduling a meeting, you can create the link and email it to
everyone in advance.

If you use your online account (https://www.zoom.us/signin) you can schedule
a meeting from the top menu or using the meetings tab on the side menu:

Share screen -

You will see a list of scheduled meetings. Only one meeting can run at a time
on an account. Zoom does not warn you of a clash so take care to monitor it.

e

ZOO' l l SOLUTIONS ~ PLANS & PRICING CONTACT SALES M JOIN A MEETING HOST A MEETING ~ CT'
REFRSORAL Meeﬁ ngS Recently Deleted Get Training
Profile
Upcoming Previous Personal Room Meeting Templates
N
Webinars & to Schedule a Meeting
Recordings Tue, Mar 16
Settings
11:30 AM - 04:30 PM Zoom Basic Leading Training Elizabeth
Meeting ID: 851 7689 2650
ADMIN
> User Management Thu, Mar 18
> Room Management 5
09:00 PM - 10:00 PM My Meeting
> Account Management Meeting ID: 840 5558 7341
> Advanced
Fri, Mar 19
11:30 AM - 01:30 PM Zoom Advanced Training - Elizabeth
Attend Live Training Meeting ID: 890 7320 8574
Video Tutorials

On a shared account you may want to schedule the meeting for half an hour before and after the expected
meeting time to give spare time to set up and run-on if necessary. Note that timings are only for scheduling
purposes. A meeting can be started at any time before the specified closing time. It can therefore be used
for trial purposes before the actual meeting.

You are now ready to schedule a basic meeting. To get full functionality out of Zoom (such as breakout
groups) you will want to ensure that all the right settings are in place. See the Section on Settings later in
this booklet.

Optional for the technologically savvy:

It is also possible to install a Zoom app into your online diary and connect and schedule meetings from
other programmes. See instructions here:

Outlook: https://support.zoom.us/hc/en-us/articles/115005223126-Office-365-Outlook-Web-Add-In

Google calendar: https://support.zoom.us/hc/en-us/articles/360020187492-Google-Calendar-add-on

Firefox: https://support.zoom.us/hc/en-us/articles/206337235-How-To-Use-Zoom-Firefox-Add-On

Chrome: https://support.zoom.us/hc/en-us/articles/201974323-Using-the-Zoom-Chrome-Extension

BW Leading Zoom Handbook 2021v2.doc 6 11/03/2021
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Choose Schedule a new meeting and fill in the sections as indicated. Note the screen shot is for the Pro
Licence. The free licence and the desktop app may have fewer options than shown.

Use 2 Temapiate

Whe

Mecting 1D

Meocting Options

( o

Enter your meeting description

(CMT+0:00) London

D Recurrng mecting

D Requived

@ Cenerate Automaticaly O Personad Mecting 1D 296 645 2775

Passcode | 467605

Waitieg Room

D Requive authentication to join

Haost @ o0 O oft
Participant @ on O oft

O Telcphone O Comgeter Audio @ Both

O troon United Kingdom  Edit

D Allow participants 10 jain avtine

D Mute particlpants upon endry

D Breakout Roam pee-assign

D Autcmatically recoed mecting

D Enabic additional data center regions for this meeting

D Approve or block entry to Lsers from specific fregfons/countrics

Ensure you click save at the bottom of the page to
complete the scheduling of the meeting.

BW Leading Zoom Handbook 2021v2.doc 7

Add topic and description for
clarity.

Insert date, duration, and time.
Allow a little time before and
after. A recurring meeting will
keep the same link every week.

NB: You can run the meeting at
any time. The times are
indicative not restrictive.

Registration: Sets up a Zoom
online registration system for
registering an interest.

Passcode: This is mandatory. People
on landlines must have a numeric
code. Change with care.

Waiting Room is set as default but
can be removed.

Require authentication is added
security, leave as is.

You can set video to start
automatically. Individuals can
override your choice.

Click Advance Options in the desktop
programme/ app to see these:

e Allow participants to join anytime, without
you having arrived in the room. Less secure but
lets people meet for a coffee morning without
you being there. You must also untick waiting
room.

e Mute participants on entry: This will mute
participants as they join the meeting. They can
unmute themselves after joining. Optional

e Breakout Room pre-assign: Allows you to set
up breakout rooms in advance. This only
appears if you have enabled it in settings.

e Automatically record meeting: Saves you
remembering to record but note that the files
will be larger in the limited storage space.

e Enable additional data centre regions.
Ignore this.

e Approve or block entry. Ignore this.

11/03/2021



© Zoom - [u] X
In the desktop programme/app you will then return Mo ity i i b
to the programme where it will tell you the next 2 ey IEER ®
meeting to start. You can see your scheduled 524556 6871 Spiiestig
meetings by clicking on the Meetings Tab at the top prm—— e T
of the screen. On the left is a list of scheduled Today - A
meetings. Click on any meeting and you can: bk A e >

Show Meeting Invitation

Meeting ID: 842 7124 1860

e Start the Meeting.

My Meeting
e Copy the invitation to send people. e
e Edit the settings for the meeting. s

Meeting ID: 869 7027 1261

e Delete the Meeting.

If you scheduled your meeting in your online account, then you will get a confirmation screen where you
can check your meeting and start it if you are ready to do so. You can also set up polls and registration (see
below). Edit this meeting allows you to make changes to the meeting setup. If you have an outlook, google
or yahoo calendar, you can add the meeting to your calendar by clicking on the tab.

Inviting Participants

PERSUNAL

My Meetings Manage "Zoom Basic Leading Training Elizabeth”

Start this Meeting

Zoom Basic Leading Training Elizabeth

Mar 16, 2021 11:30 AM London

Recordings Add to [ B Googte Calendar J [ (= Outiook Calendar (ics) ] L eYdhoo Calendar ]

Settings
851 7689 2650

ADMIN

v Passcode  *ttrrrt Show Waiting Room

ZiliserManagement Require authentication to join

> Room Management
hitps: #us02web.zoom.us/j/85176892650?pwd=0UZPWDNIWmMRHcnFVTENPbXIjaVIGQTO?
> Account Management

Advanced v Host On

Participant On

Telephone and Computer Audio

Attend Live Training Dial United Kingd
Dial from United Kingdom

Video Tuterials
v Allow participants to join anytime

Knowledge Base

Mute participants upon entry
Automatically record meeting
Enable additional data center regions for this meeting

Approve or block entry for users from specific countries/regions

Want to invite view-only participants or broadcast the event to up to 10000 participants? Convert this Meeting to a Webinar

Start Edit Delete Save as Template
Poll Live Streaming
You have not created any poll yet. Add :

The best way to invite participants is to email them a link which contains the password. Zoom provides this
for you and you can copy and paste it into an email. If you use Zoom registration, then the link will be a
registration link with a registration form.

In the desktop programme (top picture) go to the Meeting tab on the top menu. Click on the meeting on
the left and choose copy invitation from the centre of the screen.

In the online settings (picture directly above) choose Meetings in the left-hand menu and then click on the
meeting to get the details shown above. Click on "Copy the invitation"

BW Leading Zoom Handbook 2021v2.doc 8 11/03/2021



You can then paste the meeting invitation into an email (or send from your calendar if you have stored it).

All Saints Church is inviting you to a scheduled Zoom meeting.

Topic: PCC Meeting

Time: Jun 5, 2020 01:30 PM London

Join Zoom Meeting
https://zoom.us/j/209762506?pwd=YUIIYTdjV2tIZVFobWdSNGIjc1NiZz09
Meeting ID: 209 762 506

Password: 458675

One tap mobile
+13126266799,,209762506# US (Chicago)
+13462487799,,209762506# US (Houston)

Dial by your location

+1 312 626 6799 US (Chicago)

+1 346 248 7799 US (Houston)

+1 646 558 8656 US (New York)

+1 669 900 9128 US (San Jose)

+1 253 215 8782 US

+1 301 715 8592 US
Meeting ID: 209 762 506
Password: 458675
Find your local number: https://zoom.us/u/acw8m35Pav
NOTE: in the picture the link is not underlined, which means it is not live. To make it live press return at the
end of the link. Those on i-phones may not be able to use the link unless you do this.

Participants can join the meeting via:

e Desktop computers (they may need to add camera and microphone to their desktop)

e Laptop / tablet or i-pad (has inbuilt camera and microphone)

e Tablet/i-pad/smart phone (has inbuilt camera and microphone but slightly limited functions)
e By landline telephone at national rates. (Voice only, no pictures).

By default, the American phone numbers are shown and are irrelevant to your participants. See Settings
later in the booklet for how to list the UK phone numbers. You can delete the extra details and tweak the
timings to make a simpler email. The email you send out might look more like this:

Elizabeth Harper is inviting you to All Saints PCC Meeting

Time: 5 December 2021 at 7:00pm
To join the Meeting click on this link:

Or if you have Zoom installed, you can join the meeting manually with these
details:

Meeting ID: 209 762 506

Password: 458675

If you wish to join the meeting by landline phone instead, please ask for further
details.

BW Leading Zoom Handbook 2021v2.doc 9 11/03/2021



Tables, i-pads, and phones have a different Zoom layout to desktops and laptops, for instance the main
menu is at the top rather than the bottom. If possible, try and look at Zoom on different media to get a feel
for what your participants might see, so you can guide them. The Bath and Wells Joining a Zoom Meeting
Handbook gives screenshots for different media and is designed for participants with some understanding,
but not a great deal of computer knowledge. It is free to circulate to your participants. The Zoom support
videos will also let you see different devices.

Participants joining on a Laptop or Computer. O zeem x
Joining on a laptop or computer gives the fullest Zoom participation. The first time Enter your name

they join a meeting they will need to download the basic Zoom app onto their ®
computer. The screen instructions should guide them in doing this, but they may Remenber my rame for fture meetngs
need help finding the programme after it has downloaded to run it. Running the

programme will ask them for their name and then they can press Join Meeting. = -

The main menu is along the bottom of the screen and can be accessed by hovering
the mouse along the bottom. Gallery/speaker view toggle is in the top right.

Participants joining on a Tablet or Smart phone.

Joining on a tablet or smartphone can be more convenient but the size of the Start a Meeting

screen means that fewer people will be visible, and some facilities are Sleforpaise medlig o ihe D
unavailable (e.g., files shared in chat are not available). Participants will need to
download the free Zoom Cloud Meetings App from their App Store and install it ]
before they can join a meeting. +

The main menu is often along the top of the screen. Different screen views _ ‘
(gallery/ speaker) are often achieved by swiping right or left. N* g

Participants joining on a Landline. ———

If people do not have internet, they can still join a Zoom meeting with their

landline, but obviously cannot see anything. This is only possible if you as host
have a Pro licence. A meeting hosted on a free account can't be joined this way. Sign Up Signin

Detailed instructions for joining via a landline are found in the Joining a Zoom
Meeting Booklet. You will need to provide the participant with the number to call (see Settings below). The
numbers in January 2021 were the following national rate numbers:

London: 0203 481 5237
London: 0203 481 5240

The Participant will need the meeting id and passcode which will need to be
numeric. A trial meeting beforehand with anyone coming on via a landline is
recommended.

BW Leading Zoom Handbook 2021v2.doc 10 11/03/2021



Registration

Zoom provides an online registration platform for people to
register for your meeting. If you want to allocate people to
breakout rooms prior to the meeting, then you will need to
use the registration facility. Tick the registration box when

scheduling the meeting.

Having saved the meeting, click on it and scroll to the

Time Zone (GMT+0:00) London

[ Recurring meeting

Registration <E| Required >

bottom to set up.

Registration Email Settings Branding Poll

Registrants: 0

egistrat Automatically Approved

Send an email to host

Close registration after meeting date

v Allow registrants to join from multiple devices

+ Show social share buttons on registration page

Live Streaming

View

Manage registrants will let you view who has
registered and resend the confirmation details.

Registration Options sets out the conditions and
information to be collected from registrants. Choose
Edit and tick the desired boxes. Under Questions you

can choose fields such as Name, email, address
that must be given by the registrant. These can be
made compulsory or optional to answer. Under
Custom Questions you can add further fields of
your own:

Registration

Registration Questions Custom Questions

Create Your Own Question

You are prohibited from soliciting confidential personal information (sy
information or social security numbers) in your registration questions.

Registrants for 'dummy registration meeting'
Search by name or email Seary
D Registrants Email Address Registration Date
O Lizzzie Harper elizabeth@eharper.org fr:] 22,2021.11:54 Copy
0 Elizabeth Wells eIaabethJ_'rarper@bath Jan 22,2021 11:48 o
wells.anglican.org AM
¢l Registration || Resend Confirmation Email < o 5
Registration

Registration Questions Custom Questions

Approval
(@ Automatically Approve

Registrants will automatically receive information on how to join the meeting.
(O Manually Approve

The organizer must approve registrants before they receive information on how to
join the meeting.
Notification

[[] Send an email to host when someone registers

Other options

[ Close registration after event date
Allow attendees to join from multiple devices

Order  Your Questions Requird Show social share buttons on registration page
1 What Parish/ Benefice are you in?
[ . HEPS
2 What would you like covered in this session? Delete
3 Do you do Zoom on Delete
New Question
BW Leading Zoom Handbook 2021v2.doc 11 11/03/2021




Then Choose Email Settings. There you can edit the email contact and the Confirmation email.

The confirmation email will be
automatically sent to everyone who
registers. You can change the email at
any time and resend it. It can be useful
to rewrite the email and resend it as a
reminder a couple of days beforehand.

Each registrant gets a unique login, that
enables Zoom to recognise them when
they enter the session. This means you
can use the email address given to pre-
allocate breakout rooms in the
scheduling window.

Now scroll back up the scheduled
meeting to pick up the invitation from
the normal place. The invitation will now
be a registration invitation.

Confirmation Email

[ASend Confirmation Email to Registrants

Subject

[Meeting Topic] Confirmation

Body
Hi [User Name],

Thank you for registering for "dummy registration meeting".

\

We are looking forward to you joining this session on Zoom. Please ensure you have paper and pen
handy.

\.

Please submit any questions to: elizabeth.harper@bathwells.anglican.org

Date Time: Jan 22, 2021 03:00 PM London

Join from PC, Mac, Linux, iOS or Android: [Join Link]

Passcode: 628524

Note: This link should not be shared with others; it is unique to you.
Add to Calendar Add to Google Calendar Add to Yahoo Calendar

Copy Meeting Invitation

Meeting Invitation
Hi there,

You are invited to a Zoom meeting.
When: Jan 22, 2021 03:00 PM London

Register in advance for this meeting:
https:/usO2web.zoom.us/meeting/register
/tZUsdOmvrDwWoGNFsZwB66rYtzYYWIb9XviMV

After registering, you will receive a confirmation email containing information about joining

the meeting.

Conv Meeting Invitation

he one-tap

H Kingdom: +442034815240,,81130727225# or +442034815237,81130727225#
hone:

br higher quality, dial a number based on your current location):

ted Kingdom: +44 203 481 5240 or +44 203 481 5237

ng ID: 811 3072 7225

bde: 628524

Jational numbers available: https:/usO2web.zoom.us/u/khTMvfuHx

cancel your registration at any time.

Cancel m_Canrﬁl_

Meetings Meeting Report Report Queue
A list of those who have _ E—

Webinars
regIStered is avallable |n the Report Type @ Registration Report O Poll Report

H H sl Search by time range From: | 10/22/2020 4 To:| 10/22/2020 ]
Admin Setting >Reports> L ' B T =
Meetings Choose "Generate" Settings Maximum report duration: 1 Month
to generate a report of who has ik O scheduledTime  Topic Meeting 1D
regISte red . Th en 80 to Re po rt > User Management () ;202)2028505’3 Chaplaincy Gathering - Chaplaincy and Covid - Hope %831571843 Generate
Queue to download the list to
an Excel sprea ds h eet 7:Rodm Management O 111([)2)202(/)30;\23 Chaplaincy Gathering - Chaplaincy and Covid - Justice 97;659::)89 Generate
p ' v Account Management

P () 3;)1)202&2)?:3 Chaplaincy Gathering - Chaplaincy and Covid - Loss 93;1!:;15 Generate

Account Settings

Billing

Recording Management

IM Management

> Advanced o
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Starting a Zoom Meeting

Choose an application to open the zoommtg link.

You can start the Zoom Meeting from the confirmation
screen or from the Meetings tab if you have set up the
meeting beforehand. Click on start meeting. Choose other Application Choose...

You may be asked to download a Zoom app onto your
desktop if this is your first Zoom session. Or to launch
the Zoom App if you are starting from the online
settings.

Always use this application to open zoommtg links

You may be asked to choose your settings if you have

not already set defaults, e.g. join with video or audio. You may have the opportunity to test your speaker
and microphone to see that it works with Zoom.

If you are likely to run frequent
sessions, then a headset is
advisable. It prevents background
noise reaching participants and
sharpens the audio quality. You
can often use the headset

that came with your i-

phone. The main thing to

check is that your headset has the
right connection for your computer. If in
doubt a USB connection will work with
laptops and desktops.

© Choose ONE of the audio conference options

Phone Call Computer Audio

It also pays to think about where you place your computer/laptop if you can move it. Different lighting will
mabke it harder or easier for people to see you. If your inbuilt camera is not good you may want to purchase
a specialised camera.! Remember hard of hearing people may need to read your lips.

With Logitech Brio webcam With built-in laptop camera

(15 inch MacBook Pro)

! Picture from: https://blog.zoom.us/wordpress/wp-content/uploads/2020/03/work-from-home-lighting.png
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Leading a Zoom Meeting
Preparing for the Meeting - Microphone and Video

The key to a good meeting involves setting everything in place before the meeting starts, so that delays are
minimised. You can log in before the session (provided no-one else is having a meeting) to do this. The
main controls are along the bottom. First check your microphone and camera work using the main menu:

© Zoom Meeting ID: 209-762-

Microphone button:

If you or your participants are having
problems with the microphone or sound,
check the settings from the up arrow by
the mute button. Check the right

Select a Speaker microphone and speakers are selected

v Speaker/HP (Realtek High Definition Audio) and test the microphone and speakers.

Same as System The mute button toggles the
microphone on and off.

Select a Microphone
v/ Microphone Array (Realtek High Definition Audio)

Same as System

Test Speaker & Microphone...
SUiitch to Phone Audio Holding down the space bar should
unmute you for a quick comment. You

i . can also set a shortcut Alt A in shortcuts
Audio Settings... )

Bl to quickly mute and unmute yourself.

5top Video Select a Camera

Leave Computer Audio

v Webcam C110

Video controls: :
Choose Virtual Background...
The video controls allow you to choose cameras, set

video settings and choose a virtual background or Choose Video Filter...
video filter.
These are explained further below. Video Seftings...

e
Stop Video
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Welcoming and Managing Participants

Please wait, the meeting host
Participants arrive, by default, in a waiting room. This can be disabled when will let you in soon
scheduling or during the meeting. Personalise the waiting room in the

online account settings (see Settings).

. - o
$ @ - a2 ea ®

Mute Stop Video Security Participants = een Breakout Rooms Reactions

S—
Participants Panel = <
This panel shows who is in the meeting, their status and who is waiting. ¥ Participants (2)
If it appears in the centre of your screen obstructing the videos, then oI WAl —
choose Exit Full Screen from the View menu and it will jump to the side.
The Participants panel allows you to control participants e.g. mute, Sl E oo
Sp0t|lght, make CO‘hOSt. 1 participant in the meeting
Jmte Mute All l Contr0|S are aVa'IabIe at BathWells Comms (Host, me) ? ¥
T the bottom of the - adidipndie il
SkAYRa nmute Participants panel. The More
/ Ici ¢ . Q Find ici
Mute Participants upon Entry "oMiab gives further useful nd a participant
v Allow Participants to Unmute Themselves settingsl. @ Filzabesh Harper (Me) ¥ o
v Allow Participants to Rename Themselves
Play sound when somecne jeins or leaves Participants only have the i i e i e
Enable Waiting Room Mute and invite options. (oa § o
Lock Meeting (Raise hand is now under
. m Ann 2 ™
Reactions).
. . . L. m Karin Z x
Controlling the Videos and Microphones — Mute/Unmute Participants =
Margaret ¥
When participants are not using directional microphones (e.g., a headset or =
specialised microphone), background noise or feedback can cause o g—

problems. In a large meeting you may want participants to mute

microphones except when they are invited to speak. Hosts and co-hosts can mute everyone. If participants

routinely unmute themselves. You can untick "Allow Participants to Unmute Themselves" in the

Participants More button (see above) which will prevent everyone unmuting. Make any readers or guest

speakers co-hosts so they can speak. If a person has continual noise problems a headset should solve the
problems for future meetings.

For privacy purposes Zoom does not allow a host to unmute

T ——— participants. You .ne-ed to ask them to unmute..lt is po.55|ble.to
Belaire? collect that permission at the start of the meeting. This setting
You can withdraw permissions at any time in Settings > Audio. . .

needs to be enabled in the Settings (see below).

m Don't Allow | Lock Meeting
Enable Waiting Room
Security Hide Profile Pictures
The Security button on the main menu (hosts and co-hosts) allows quick Allow participants to:
access to controlling participants and what they are able to do. Shaiesaeen

Chat
e Lock meeting prevents new people entering the meeting. Rename Themselves

Unmute Themselves

e Remove Participant - removes them from the Meeting> They cannot
return unless you have allowed this in your online account. You will
have the option to Report the Participant's behaviour to Zoom. Reémupye Sartidpdns

Start Video

e Suspend Participant activities turns off all participant activity.

BW Leading Zoom Handbook 2021v2.doc 15 11/03/2021



Gallery, Speaker, Spotlight Views and Virtual Backgrounds
Zoom allows you and participants to arrange the camera views in two different ways:

e Speaker View has one big picture of the current speaker and small pictures of everyone else.
e Gallery View has equal sized pictures of everyone (to max of 25/49 depending on your settings)

These two views apply only to your own screen and participants are free to view their screen as the like.
There are 2 ways to control participant's screens: Spotlight view, overrides participants choices and forces
them into speaker view with the person you have highlighted dominant. Follow Host's video rearranges the
pictures on gallery view to match yours.

1. Speaker View

This is most useful if one person is doing most of the talking, as in a presentation or classroom. It is also
useful if your screen is small, or there are a large number of people. Depending on the device the small
pictures of other participants may be at the top or bottom of the screen.

On a laptop and desktop, you can change to speaker view by clicking on "View" in the top right corner.
On a phone and most tablets, you can change view by swiping the three dots at the bottom.

"\i? : ‘ E

EWEs = _C D

WY

:
i

" _‘ . abeth Harper

@ Speaker View 77

LJd
2. Gallery View
This is most useful in a small meeting or discussion group where everyone participates equally. Gallery
view tiles all the participants on the screen at equal size. The more people in the meeting the smaller the
tiles, with a maximum of 25/49 (if set) on a computer. A tablet/phone will
have a more limited number of tiles. Further participants can be seen by
scrolling with the arrow buttons. It is possibly to drag pictures around the
screen to create a desired order and see people where you would like to see
them. A host dragging pictures can then change the order for everyone, by
setting "Follow Host's Video Order" which now appears on the View menu.
Fullscreen Participants can only change their own screens and cannot even do that if

Follow Host's view is ticked:

Speaker View

v Gallery View

Follow Host's Video Order

Release Video Order

228 Gallery View
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3. Spotlight a Speaker. T

Ask to Unmute

Spotlighting a speaker forces all participants to view
the spotlighted person in speaker view. It is the one

Stop Video

Chat

command that overrides participants screen layouts, ‘ Rename

although people can change back if they wish. It is : Pin Video to First Screen
particularly useful for the main speaker or the ' Pin Video to Sedeqd Screen
preacher in a service. Other participants can still be el

seen as small tiles that can be scrolled as in Speaker :::: :::,“

view. Up to 9 people can be spotlighted at a time. Refove

When recording or streaming only the spotlighted Put in Waiting Room

people appear which makes this a good privacy mechanism.

It is also possible to highlight one speaker for your own benefit. Pin Video will make one picture visible for
yourself only.

To spotlight or pin a video, hover the mouse over the top of the chosen person's video picture and click the
three dots 'more' menu to get up the menu. The same menu is available on the Participant's Panel.

© settings
4. Virtual Backgrounds
The webcam will pick up whatever is behind you,
which may be embarrassing or distracting for o

those watching. Zoom allows you and participants

to choose a static or video virtual background, © recoring
@ Statistics

that may be less distracting. Take a look at the

. . © Freedback

image on the cover of this booklet. = A

Accessibility
Select a Camera
v Integrated Camera
3 - 4 Video Settings...
= T Choose Virtual Background
BathWells Comms
\._/ ~ [} ~ C—— T —

Stop Video

Virtual backgrounds are not available on smartphones, tablets and older machines. Virtual backgrounds
can be opened from the Stop Video up arrow button on the bottom menu. There are now also video filters
to add humour or texture to your photo. Again both must be enabled in the account settings.

On the Virtual background tab, you will find the available backgrounds under Choose Virtual background. If
"None" is showing, then there are no pictures preloaded. If you have some of your own pictures in a folder,
click on the + tab and navigate to your pictures folder and choose something appropriate. Blur blurs your
background so that background is not identifiable. Untick green screen for best quality if allowed.

The camera has to merge the picture of you with the background. You may find that your image gets badly
distorted and the virtual background is more off putting than helpful.

BW Leading Zoom Handbook 2021v2.doc 17 11/03/2021



Responses, Feedback, Polls, Voting
1. Participant Responses

Participants have some quick visual responses that they can give to your presentation. Under the Reactions
tab on the main menu, they can choose an emoticon from the
top line. These appear in the top right of their video for 10 :
seconds and in the Participants Panel. ~ ‘ e O

v X <« »
2. Non-verbal Feedback

Yes No Slower Faster

It is possible to have participants give further responses by
enabling non-verbal feedback in the settings of your online
account. These icons also appear on the Reactions tab (they
used to appear in Participants panel). The Yes/No buttons are useful for a quick show of hands or vote. On
the host screen, in the Participants Panel, Zoom tallies the yes and no numbers so that you know instantly
how many are in favour or against the vote.

J Raise Hand

The raise hand button is useful for participants to get your attention. With large numbers, a waved hand is
not always visible. By using the raised hand reaction, the person's picture jumps to the top of the screen
and their name appears at the top of the Participant's List for easy identification.

3. Polls

If you wish to carry out a more extensive questionnaire of participants or hold a secret ballot, then
enabling Polls in settings may be more helpful. This is now

unavailable on the free licence. Up to 25 polls can be created Edit Poll 1

before the session with single or multi choice options, and T —
several questions in each if desired. Unfortunately, open ended & Anonymous? @
answers are not possible. 1

Are you in favour of the appointment of a new Youth
Worker?

After scheduling a meeting in the online account, look at the
meeting (click on its name) and you will find a polling section (if

enabled) at the bottom of the meeting details. Click on "add", @ Single Choice O Maltile Choice
and a poll form will appear. You can make the poll anonymous Yes
if desired. No

Only if the Smith legacy can be applied to the salary

Answer 4 (Optional)

Answer 5 (Optional)

rd the meeting automatically
Record th: eeting automatically Answer & (Optional)

Enable additional data center regions for this meeting Answer 7 (Optional)

Answ

(Optional)

Delete this Meeting Save as a Meeting Template Edit this Meeting Start this Meeting Answer 9 (Optional)

Answer 10 (Optional)
Delete
You have created 2 polls for this meeting. Add
Title Total Questions Anonymous %.AddaQuestion
v Poll 1:Youth Worker Appointment 1 question Yes Edit Delete
m Cancel
v Poll 2:Auditors 1 question Yes Edit Delete
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© palls == (]
Once in the meeting, click on Polls in the main menu. And the first poll will
come up. Clicking on the down arrow by edit will allow you to choose a
d iffe re nt po I I . 1. Are you in favour of the appointment of a new Youth Worker?

Polling 1: Youth Worker Appointment

Yes

Launch Poll to get responses. You will see the progress of the poll and how
many people have voted/ answered. When you are satisfied that all "

answers are in, End Polling and you will see the full results which can be e e e
shared with everyone. (Take a screen shot if you wish to retain the results)

Q © Polis - O X

Youth Worker Appointment in Progress 0:15 Polling 1: Youth Worker Appointment

1. Are you in favour of the appointment of a new Youth Worker?

Yes 0) 0% Launch Polling
Yes 1) 100%
°
No 0) 0% a' III .

No 0) 0% Participants Polls Chat

Only if the Smith legacy can be applied to the salary 0) 0% )
Only if the Smith legacy can be applied to the salary 0%

End Polling Re-launch Polling

Recording and Streaming

Sessions can be recorded using the record button on the bottom menu. Clicking on this will start the
recording. It can be paused or stopped, as necessary.

= N
-t | @ BE -]
Invite Manage Participants Share Screen Record ireakout Rooms Reactions
S —_——
With a free licence the recording is stored on your own computer. With a pro licence there is the option to
store the record on the Zoom cloud or your own computer. Recordings of an hour's session produce very
large files. You may prefer to record the session in smaller chunks. The recording only records the main
meeting and screenshares, so pause during

breakouts to save a blank screen. -
<« Documents > Zoom > 2020-05-07 14.13.01 Exploring Christianity - Elizabeth H 87883195843
If saving to your computer, you will receive a _— - —
. . I
message when the meeting ends. If the session > [ TR 07055000 1631
is large, saving may take 15 mins or more. It 8 audio_only_1.mda
may ask you where to save the video. If not, the | = p'ayba;"'"‘pi”
5 zoom_O.m
file is normally saved in your Zoom folder B 2ocmciiid

(automatically added to the bottom of your File
Explorer) or possibly in Downloads. M4a files are audio. MP4 files are video. If spotlighting has been used,
only those spotlighted will be seen in the video, which gives participants privacy. Programs like Dropbox or
WeTransfer can be used to send the files, which are likely to be too large to email.

To find your cloud saved recordings go to your Online account. Recordings are saved in the Recordings tab
under Personal on the left-hand side. From there you can send a link that enables people to view or
download the recording or download it yourself. You have 1 Gb of storage or about four 90min sessions.
You will need to regularly delete recordings to make space for new ones.
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PERSONAL : - — . .
Cloud Recordings Local Recordings Share this cloud recordlng
Profile e —————
Share this recording ()
Meetings From To 25-02-2021 Al Stat
= .- O Publicly
Webinars " "
Searchby D = Erport Only authenticated users can view
Recordings
_ Add expiry date to the link ()
Settings Delete All
Viewers can download . )
(] Topic D Start Time File Size
ADMIN View recording on demand (registration required) © C)
O CMD/TIM Officer 8339509 1986  Feb 16,202109:57 2 Files (677 KB) S
User Management AM .
Mores Passcode protection ()
RoomManagement e [
FTech 85683291480  Feb2,202101:59 3 Files (181 Download (2 files)
Account Management PM
Delete
Adianced Sharing Information Show v
Reader Training IME1 & IME4 83516355794 Oct 18,2020 09:22 6 Files (523 MB) Share.
AM 2 z
More ~ Copy Sharing Information Done
Streaming

It is possible to livestream your session to Facebook, You Tube or a custom site such as your website. This
may allow you to reach a larger audience. There are copyright issues involved in live streaming or posting
recordings publicly and you may need to have at least a CCLI streaming licence. Facebook and You Tube are
known to block content that their computer programme deems copyright protected, but it is possible to
contest this. Most churches have the music reinstated. Blocking often involves muting the song or sending
you a message and usually happens after the live stream is completed, so only disrupts those viewing later.
Facebook is more sensitive than You Tube and so some churches stream to You Tube and post a link on
Facebook. Copyright is complex, so do talk to CCLI about what you are doing and what licences are needed.
The following webpages might be helpful:

e https://lawandreligionuk.com/2020/03/17/streaming-church-services-an-updated-guide-to-
copyright-and-religion

e https://www.churchofengland.org/resources/digital-labs/blogs/beginners-guide-going-live-your-
service-or-event-free

e https://www.churchofengland.org/resources/digital-labs/blogs/guide-getting-started-live-

streaming

You will need to allow live streaming in the
Online Account settings> In Meeting
(Advanced). This will then provide a menu
item in the Host's menu. The streamed
service is often 20-30secs behind Zoom.

a) Facebook

Securty
Schedule Meeting
In Meeting (Basic)
In Meeting (Advanced)
Email Notification

Other

Allow livestreaming of meetings ()

Facebook
Workplace by Facebook
YouTube

Custom Live Streaming Service

You can stream to your Facebook timeline, a Facebook group or
your church Facebook page through Facebook Live. People
watching the Facebook stream can comment in real time on the
Facebook comments so that there is some interaction still possible.

Open Facebook in your web browser before the meeting. Choose
"Live on Facebook" from the Host's More Menu. When prompted
choose where to post your video. Facebook will prepare a live
stream preview. When completed click "Go Live". You will be
returned to your desktop. Re-enter Zoom. Shortly you will be
notified that you are live and then you can start the service. You
can stop the live stream from the main menu or from the top right-
hand corner. See https://support.zoom.us/hc/en-
us/articles/115000350406-Live-streaming-meetings-or-webinars-

on-Facebook for problems.
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https://support.zoom.us/hc/en-us/articles/115000350406-Live-streaming-meetings-or-webinars-on-Facebook
https://support.zoom.us/hc/en-us/articles/115000350406-Live-streaming-meetings-or-webinars-on-Facebook
https://support.zoom.us/hc/en-us/articles/115000350406-Live-streaming-meetings-or-webinars-on-Facebook

When live, the video can be watched by anyone looking at your Facebook news feed. People do not
need to belong to Facebook to see the video, but they will need to have a link, which you will need to
distribute. The link is only generated when you go live, so this can be a bit tricky. Some churches
delegate this task and start the service 5 mins early with some pre-recorded music. This gives time to
email out the link and have people join.

When completed the feed will be blank while Facebook process the live stream and it will then be

visible for people to watch at any time. Effectively you get a live stream and a recording for future
viewing.

b) You Tube

Open You Tube in your web browser prior to the service and log | Broadcast Zoom Meeting to YouTube Live
into your account. In Zoom choose "Live on You Tube" from the
Host's More Menu. If prompted choose which You Tube Channel
to broadcast to (if you have more than one). When requested give Zoom mecting e onYouTube
your Service a title and choose privacy settings. When completed [ zoom Live stream
click "Go Live". You Tube will prepare for streaming and you will privecy

see a progress counter. When it completes you will be returned to Peble

your desktop or Zoom. Shortly you will be notified by Zoom that “
you are live and then you can start the service. You can stop the

S Connected o Not me

live stream from the main menu or from the top right-hand corner.

It is also possible to live stream to a YouTube Event that has been set up and prepared for before and
may be a recurring setting for every Sunday. This enables you to email prior notice. For further details
and any problems see:

https://support.zoom.us/hc/en-us/articles/360028478292-Live-streaming-meetings-or-webinars-on-
YouTube

¢) Custom Service

You can use the custom service to live stream to
some other medium such as your website. You will
need to open the administration version of your
destination. In zoom, when you choose Live on
Custom Live Streaming Service you will be asked for
Streaming key the details. When complete click "Go Live":

Enter a streaming Key Show

Live stream the Zoom meeting to a custom service

Streaming URL

Enter the streaming URL

When it completes you will be returned to your

Live streaming page URL desktop or Zoom. Shortly you will be notified by
Enter a live streaming page URL Zoom that you are live and then you can start the

Everyone whotses this ok canwroTihe e brosdcast service. You can stop the live stream from the main

“ menu or from the top right-hand corner.

OBS (Open Broadcaster Software) is a popular free software for video recording and live streaming. You
can use it to stream directly to Facebook, YouTube etc. but you can also integrate it into Zoom - as a virtual
webcam to feed into Zoom, or the more complex option of Zoom feeding into OBS. There are online
tutorials to help you, or use Facebook Groups such as TechnoChurch to find other churches who are doing
this.
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Participants Rights and Views

Participants see a similar screen to the host, but with fewer controls. If you have permitted these features
their menu may look like this (i.e., they can't see security, polls, breakout rooms):

Chat Share Screen Record Reactions

The following permissions need to be set in your online account before they can be used by participants:

Permission Where enabled Permission Where enabled
Allow Participants to join Schedule Meeting Non-verbal feedback (Voting) In Meetings (Basic)
before or without host and Reactions

Chat and private chat In Meeting (Basic) Allow participants to rename In Meetings (Basic)
File Transfer In Meeting (Basic) Hide profile pictures In Meetings (Basic)
Co-hosting In Meeting (Basic) Allow virtual backgrounds filters|In Meetings (Adv)
Screen-sharing including In Meeting (Basic) Annotation of whiteboard/ In Meetings (Basic)
desktop, whiteboard shared screens

If these permissions are enabled, then in the meeting you can control, i.e., turn on and off as needed:

Permission Where enabled Permission Where enabled
Muting and Unmuting Participants Panel Share screen Security, Share Screen
and Security Video Settings>Share
Chat Security and Chat Renaming themselves Security and
Show video (i.e., camera) Security Names on video pictures Video settings> Video
Accessibility e.g., captions |Video Settings>
Accessibility

If you wish the Participant to participate more fully e.g., to give their own presentation or be the guest
speaker, then it is best to make them a co-host. Co-hosts have more rights and actions available than
Participants but are not able to rename, poll, make other co-hosts.

If you wish a meeting to continue, after you leave, then you will need to make someone else host in
Manage Participants. If they have a Pro licence, then the
meeting will carry on indefinitely. If not, then the meeting

may close 40 minutes after you leave. o
viute

Controlling Participants I @l Stop Video

Participants can be controlled from the Participant's Panel, Si

or, on a desktop/ laptop from the top right corner of their
video camera. The same menu is available in both places. It
includes individual muting and stop video, chat, pin,
spotlight (add or replace), make host or co-host, rename,
allow to record, remove or report to Zoom (for a serious _ '
offence such as zoom bombing). ; £i % Allow to Record Local Files

Pin

Make Host
Make Co-host

Rename

Participants only have chat and pin available from their ' - === Allow to Multi-pin
menus. Co-hosts have the same as hosts except they
cannot make hosts, co-hosts, report or rename
participants.

Put in Waiting Room

Remove

Report...
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Sharing files, screens and information

Starting Screenshare

It is possible to share a range of files and activities during a meeting. Such as:

e Whiteboard. © Settings

e PowerPoint.

General

e Word or Pdf Document. video

Window size when screen sharing:

Fullscreen mode © Maximize window N

e Web browser, You Tube videos and -3 8 T i

websites.

e Any other programmes on your
computer.

indow

Show my Zoom Windows to other participants when | am >
/

Enable the remote control of all applications
Lo Chat Side-by-side mode @

Background & Filters Silence system notifications when sharing desktop

e NB. To share the Zoom screen itself or
the Zoom App you need to turn on "Show my Zoom Windows to other participants when | am
screen sharing". This is only available with the Pro licence and can be found in Settings> Share
Screen. It does have the effect of seeing Zoom with Zoom which can be a bit disconcerting so you
may want to leave this off as default.

Preparation is the key to a smooth meeting. Before the meeting, it helps to open all the files/videos/
PowerPoints etc. in separate sizeable windows. Size each window so that that the Zoom menu at the top
and the video panel at the side will not overlap the window. Enter Zoom and screen share to check this is
the case. Then minimise each window so that you can quickly access them. On the screenshot below, the
blue line under a program indicates it is open and minimised. To keep the computer stable it is a good idea
to close any other programs you will not use in the session to minimise computer activity.

When ready to share your screen, choose the green screenshare from the bottom menu in Zoom (share
contents if you are using a tablet or smart phone).

8 @ - 222 O + (-]

Mute Stop Video Security Participants g Record Breakout Rooms Reactior
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Basic Screensharing
Under the Basic Tab you will find a picture of all the screensharing options.

e First will be "Screen" or "desktop" options. These will share the computer desktop. Anything you do
on the desktop will be visible to the participants. This option allows you to demonstrate things and
swap between programmes such as You Tube videos, PowerPoints, and Word documents.
However, those watching do see your desktop and all that you do.

e Whiteboard - like a real whiteboard, a virtual whiteboard can be drawn or written on, with the
added bonus that participants can also draw or write on it, for a group activity.

e |-phone, i-pad, shares the screen of any i-pad or phone connected to your computer by cable or
wireless. You may need to install a plug in. See https://support.zoom.us/hc/en-
us/articles/201379235 for further details.

e Any applications or programmes that are open on your desktop - these will appear as separate
pictures. If there are too many to see you will need to click "Show all windows" to reveal further
options. It pays to close all programmes that are not relevant to the session to make these windows
manageable and prevent private information being inadvertently seen. Sharing these screens
differs from sharing screen/desktop above. Here you share only the application or programme and
the file currently open in it. These means you can do other
things on your desktop without being seen. You can click
multiple windows (ctrl and extra windows) if for instance you
want music and a PowerPoint separately.

Hold Ctrl to select multiple windows

If you are sharing an audio or video file, it is essential to tick the appropriate share computer sound/
optimise video in the bottom corner of the screen. If people cannot hear then check these are ticked.

) Select a window or an application that you want to share A

dvanCEd F“es

V4 e

Screen 1 Whiteboard iPhone/iPad
[ ] ” =R =
-a
BW Leading Zoom Handbook 20...m BW Joining Zoom Handbook 202...m Special - Elizabeth.Harper@bath... ‘ Y drive - Message (HTML) 5

CESn
e g e -

ST ve! h 4

® |
General (Ministry for Mission Tea...* Zoom Cloud Meetings 0 Adobe Acrobat Reader DC
() share computer sound ! __ Optimize Screen Sharing )r Video Clip m
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In Screenshare

Zoom is set by default to switch to full screen (this can be turned off in settings). To exit full-screen, click
Exit Full Screen in the top-right corner or press the Escape key. While sharing your screen you can still

Stop Video Security

e LA LLIL T A UALAW VLU,

control the meeting through the controls at the top of the screen:

You may initially only see the green "you are screen sharing" and red
stop share, if you have not ticked "always show meeting controls" in
settings. Hover over these and the full menu should appear above them.
The More button lets you control various other aspects of the meeting,

as in the meeting e.g., share the sound if you have forgotten to turn it on.

New Share

- W Stop Share

\J

I ’

Pause Share

Annotate

Chat

Reactions

Breakout Rooms

Record on this Computer
Record to the Cloud

Meeting Info

Disable Annotation for Others

Hide Names of Annotators

If you are using a dual monitor set-up, you can turn on the Use Dual
Monitors feature to see the screen sharing on one monitor and
participants on the second. See https://support.zoom.us/hc/en-
us/articles/201362583-How-To-Use-a-Dual-Monitor-Display.Once out of
screen share you may want to turn this off as it will open 2 Zoom
windows, one with controls and one without which can be distracting.

Show Video Panel

Hide Floating Meeting Controls  Ctrl+Alt+Shift+H

Live on Facebook

Live on Custom Live Streaming Service

v Share sound

v Optimize for video clip

To end the screen sharing click on the red Stop Share button.

Select sharing sound mode

v/ Mono

While screensharing the Zoom Meeting
webcam videos can appear in a floating video
panel on the screen. It can be hidden or
restored if not visible from the More>
Hide/Show Video Panel.

Stereo (High-fidelity)

Turn on Original Sound

The four tabs at the top of this panel alter how the video panel looks (Minimised,
speaker mode, gallery, grid- for 6 or more people). The floating panel can be
dragged to another part of the screen if it is in the way. If dragged to the top or
bottom, it should change to horizontal mode and vertical mode if dragged to the
side. Note that the video panel will appear as a black box on participant's screen
so make sure it is not obstructing anything you wish them to see. Do size your
share windows to fit round the menu and video panel you will use.

Side by Side View

Those viewing a screenshare have a different range of options Next to the green box indicating who is

sharing there will be a view options dropdown menu. Side by side mode lets the video panel shared screen
and chat/Participants boxes be viewed side by side without
overlapping. Drag the slider to right or left .

View Options v

Zoom Ratio FittoWindow > v Fit to Window
Request Remote Control 50%

100%(Original Size)
150%

200%

300%

Annotate

Standard v Side-by-side mode
Side-by-side: Speaker I
Side-by-side: Gallery B
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Whiteboard

Sharing a whiteboard produces a whiteboard that you can write or draw on. You can also allow your
participants to write or draw on it. To do this they will need to open the Annotate option to get the draw
menu. On a desktop or laptop this is found on the View Options menu next to X is sharing their screen. On
a tablet or iphone this may often be a pencil icon somewhere on the screen:

You can open multiple whiteboards by clicking the plus in the bottom righthand corner.

You can save the
whiteboard(s) (as a
png picture file or
pdf) and email to all
participants. Do this
before closing the
whiteboard as it is

© Whiteboard - Zoom

This is a white board. On which
you can type or draw.

You can also allow participants
to type and draw together.

Drawing is easiest with a touch

|mmed|ately screen such as a tablet or
i-pad. But you can still have
cleared. i y
fun with a mouse.
* | 2020-04-06 08.40.28 Elizabeth Harper 100107417
» ] x B,
- M Properts
- - == A 4
Documents > Zoom 2020-04-06 08.40.28 Elizabeth Harper 100107417
& Pictures o
2019
2020 Revisions
moodie
Zoom Pictures Whiteboard[1]-0
@ OneDrive Leng
PowerPoints

When sharing you can control the PowerPoint just as normal with the mouse or the arrow keys. It is often
quicker to take screenshots and display them in a PowerPoint rather than attempting to access multiple
websites, handouts etc. during a meeting. If you have a dual screen, then you can set up the slide show in
PowerPoint so that your notes are on the second screen (Slide Show> Set up Slide show). For the
PowerPoint presentation "Browse by an Individuals" sets the show up in a sizeable window so you can
access the rest of your screen. The Annotate tools are available in any screenshare so you can underline
things in your PowerPoint or use the spotlight/arrow as a laser pointer.

Meetings and Trainings

with Zoom

Elizabeth Harper
April 2020
https://zoom.us/
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Set Up Show
Show type

() Presented by a speaker [full screen)

(® iBrowsed by an individual [window]!
O Browsed at a kiosk (full screen)

Show options

|:| Loop continuously until "Esc’

|:| Show without narration

|:| Show without animation

D Disable hardware graphics acceleration

Pen color: -

Laser pointer color: Q b4

Show slides
® an
O From: 1 2l To: |23 =

Custom show:

Advance slides

() Manually
®) Using timings, if present

Multiple monitars

Slide show monitor:

Automatic ~
Resolution:

Use Current Resolution w

Use Presenter View
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Word Processors

Sharing your word processor allows participants to see files. The annotate tools are available so people can
annotate the document. This is effectively a picture overlay, that will need to be saved before ending
screen share. The file itself is unchanged, so you may prefer to have one scribe who screenshares the file
and others make verbal comments.

In a breakout group you may like to get one person in the group to be a scribe on a word document they
share from their computer. You may even send them a pre-prepared document with the questions to
answer already set out.

NB: Unless you share screen/desktop, people will only see the one file open when you start. If you wish
them to see a different file you will need to share that separately. The application screen sharing does not
pick up new documents made after sharing has begun.

Sharing Participants Screens

Not only can you share your own screen, but you can allow participants to share their screens. This can be
useful e.g.

e For participants to give presentations with PowerPoint or similar. (Make them a co-host)

e For participants (particularly in breakout groups) to take notes of the discussion which can be
circulated afterwards. The group could appoint a scribe who then shares their word processor.

You can control screenshare using the screenshare arrow on the bottom menu, allowing or disallowing
participants to share through the advanced sharing option. Further Settings for screenshare can be found
in the Video Settings (the up arrow by stop video in the bottom right corner)

General . X .
Window size when screen sharing:
Video Fullscreen mode o Maximize window Maintain current size
Audio Scale to fit shared content to Zoom window
") Enable the remote control of all applications
Share Screen
Side-by-side mode (@
Y ot ; o ;
(P a Silence system notifications when sharing desktop
Background & Filters
Share applications
Recording
© Sshare individual window
Profile ) Share all windows from an application
Statistics When | share my screen in a meeting
Automatically share desktop (@ v/ One participant can share at a time
0 Feedback

o Show all sharing options Multiple participants can share simultaneously

O Keyboard Shortcuts

Advanced Sharing Options...

When | share directly to a Zoom Room

£D  Accessibility O Automatically share desktop (D - ® ss o
N
) Show all sharing options Share Screen Chat Record Breakout Rooms Reactions
) Advanced Sharing Options... X

3 How many participants can share at the same time?
Advanced | Y. perIcR

o One participant can share at a time

Multiple participants can share simultaneously (dual monitors recommended)

Who can share?

Only Host Q Al Participants

Who can start sharing when someone else is sharing?

o Only Host All Participants
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Annotating Shared Screens

It is possible for you and participants to edit a screen that is shared, if this has been turned on for
screensharing in the initial setup of the meeting. This is particularly important for the whiteboard or a
Word Processor document that is recording the discussion.

If you have started a screenshare then the Annotation tools are available from the Zoom menu in
screenshare (if necessary hover over the green "you are screen sharing" to reveal the menu):
N

o v % as o /'

Stop Video Security Participants New Share Pause Share Annotate

RALLICIC > s 1= [ NUTO T AVFAV} a sgop —
If someone else has started the screenshare, then the Annotation tools will be available from view options
on a desktop or laptop. Annotation tools are harder to find on tablets and smart phones. They may appear
as a pencil icon. If all participants can't annotate then it may be that annotation is turned off in the original
settings for the meeting. Making participants co-hosts may help.

a & O 9© O w 1 =

Stamp Eraser Format Undo Redo Clear

The menu of options looks like:

Select: Selects something already drawn. Hosts and co-hosts can select anything participants can only
select their own work.

Text: allows writing (if there is much writing to be done, a word processor is a better option than
writing in a whiteboard)

Draw: has several drawing tools
Stamp: has some pre-set shapes

Arrow/ Spotlight: highlights a particular item on the screen by pointing a named arrow/ red dot at the
item. It disappears when the next person highlights something. This is the equivalent of the laser
pointers used for projections and can be useful in your PowerPoint.

Eraser erases items. Participants can only erase their own contributions. Hosts can erase everything.

Format: changes colours, line width, font etc.
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Advanced Share Screen

The options in Advanced Screen Sharing bring your applications more directly into the Zoom environment:

() Select a window or an application that you want to share X

Basic Advanced Files

e= < T

‘

PowerPoint as Virtual Background Portion of Screen Computer Audio v Video

Content from 2nd Camera

Share sound v Optimize for video clip m

PowerPoint as Virtual Background

Currently in Beta version so still under development, this brings in a PowerPoint as a virtual background to
you. The screen moves to Spotlight/ speaker view with participants along the top. You are in the bottom
right corner of the screen as well as at the top. You can drag your picture larger or smaller.

Any slide can be chosen from the PowerPoint, and you can move through your PowerPoint, however it is
only a picture background, so animations do not appear.

Computer Audio/ Video

These open your filing system to find video and audio tracks which are then run in Zoom through your
computer audio and video programmes. They cannot be used for internet e.g.: You Tube clips but only for
material found on your computer. The Computer Audio plays in the background and you can continue your
zoom meeting in gallery or speaker view. The Video, however, converts the screen to speaker view. Share
sound and optimise video are automatically turned on, unlike Basic Share screen.

Portion of Screen and Content of 2"¥ Camera.

These share part of your screen rather than all of it and content of a second camera, which might be a
video camera or software that acts as a camera such as OBS.

File Share Screen

The third button "Files" allows you to share files from your various filing systems.
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Breakout Rooms

Setting up breakouts

Breakout rooms are available in all licences including the free licence, but they are turned off by default.
See the section on Settings.

When creating the meeting in your online account, you can do some preliminary set up by choosing
Breakout Room pre-assign. The panel allows you to add as many rooms as you want and add participants
email addresses (if using Zoom registration - this will not work with names you have not registered with
Zoom). You can change the breakout name by clicking the edit pencil next to the name.

Meeting Options Enable join before host .
UJ Breakout Room Assignment 3 woms, 3 participants
D Mute participants upon entry Assign participants to breakout rooms by adding their email. You can create up to 50
breakout rooms and assign up to a total of 200 participants.
Enable waiting room

Rooms N Taunton R

D Only authenticated users can join

Bath Archdeaconry 1
Taunton 2 1

D Record the meeting automatically

gary.watson@bathwells.anglican.org
Breakout Room 3 1

If you have not pre-assigned people, you will need to assign once people start arriving. This takes a little
time and for a large group it is worth having a dedicated person devoted to this. Open the Breakout Rooms
tab in the main session menu (available to hosts and co-hosts). While all hosts and co-hosts can create
meetings, it is the first person to open the rooms that will have control of allocations. To avoid confusion
be clear as to who is creating the groups!

() Create Breakout Rooms X
N
] ®e 1 i [ 1] 3
.+ ..- V) . Q B@E 9
Invite Manage Participants Share Screen Record Breakout Rooms [Reactio create [ 4| :' breakout rooms

If you wish Zoom can divide people randomly into groups for
you, or you can assign them manually, or let people choose Assign manually
(ensuring the groups are clearly named). Let participants choose room

© Assign automatically

If you choose manual assignment, then after creating the groups
you will need to click on assign to add names one by one from

the list provided. To speed up the group preparations people can
be assigned as they enter the room at the start, so the breakout 0-1 participants per roc [ create |
groups are ready to go when needed.

) Breakout Rooms - Not Started X .
| Allow participants to choose room
v Room 1 Assign
) Allow participants to return to the main session at any time
v Room 2 Assign
v ‘Room3 Assign 7‘\ Automatically move all assigned participants into breakout rooms
Breakout rooms close automatically after: | 6 minutes
Notify me when the time is up
Countdown after closing breakout room
Options | Recreate | | AddaRoom Set td ti 30 d
et countdown timer: v | seconds
From the Options button there are various e,
. P m Options | Recreate || AddaRog
useful settings e.g., to set the length of the

breakouts, a closing countdown timer. There is also the ability to automatically move people into breakout
rooms. This is faster and easier. If unticked participants receive an invitation to join.
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Starting Breakouts

To start the breakouts choose Open All Rooms from the Breakout Tab on the main screen. Depending on

your setting, participants will go directly to their groups or get an T — >
invitation to join. If they decline, they will stay with you in the main
room. 0 The host is inviting you to join Breakout Room:
Wells Archdeaconry
() Breakout Rooms - Not Started X

v Breakout Room 1 Assign m ‘ T

v Breakout Room 2 # Rename X Delete Assign

+ Breakout Room 3 Assign —

Joining Breakout Rooms...

Recreate v Options ¥ | Add a Room | Open All Rooms Breakout Room 3
_ It might take a few moments.

The host and the person starting the breakouts do not get assigned to a group but may join any group at
any time. To do this open the breakout button on the main menu. Click Join next to the breakout room you

wish to join.
_—
* Breakout Room 1 ‘ Join >

Eren Yaeger

+* Breakout Room 2 Join

lack Barker

Changing Groups while in Breakouts

During the breakouts you can move or exchange people by hovering over their name and choosing Move
to/ Exchange. It is thus possible to combine or split groups while in session. It pays to give people a
warning.

= Breakout Room 1 1
Breakout Room 2
Eren Yaeger +] Moveto 2 BExchange (

lack Barker

* Breakout Room 2 1

lack Barker

Participants leaving Breakouts

If enabled, participants can choose to leave their breakout group at any
time (through the button on the lower right) in which case they will
return to the Main Meeting. They can then choose to re-join their
group, through the breakout button on their main menu. Otherwise, ) 7 17:30 D
participants stay in the room until forced out by the closure of the *  07/04/2020

breakout rooms.

Should anyone fall out of the meeting altogether, they will come back into the main meeting. They will
have lost their membership of the breakout group and will need to be reassigned. It can be helpful to ask
people to take note of what group they are in, if you do not have a copy.
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Communicating to Breakout Rooms

To send a message to the groups you can use the Broadcast message button, at the bottom of the
breakouts panel. This broadcasts a message to everyone, although it is visible only for a short time.

Broadcast a message to all v Close All Rooms

If you are setting people questions to discuss in groups, then you will need to consider how they will see
these. Your PowerPoint or shared screen will not be visible in the breakout rooms. You might want to
circulate the questions in a file through the chat box (see below) or emailed prior to the session. Another
simple solution is to paste the questions in the chat box prior to going into groups. The chat box can be
opened, and the questions viewed within the breakout rooms. Alternatively, a single slide PowerPoint or
file can be sent to a member of each breakout room who will be responsible for sharing it within the room.

In the Breakout Rooms participants have an "Ask for Help" button to call the host. Clicking this will result in
a message to the host who can then visit the group to offer help.

ORI T as

Leave Room

Join Audio Stop Video Participants Chat Share Screen Record Ask for Help Reactions
S’
Timed Breakout Rooms

If a time for the groups has been set in the options, then the breakout rooms will have a timer in the top
right corner showing how much time is left. When the time is up then, either you will receive a notice (if
this was selected) and can close the breakout rooms OR the rooms will automatically be closed and the
countdown timer begin.

Ending Breakouts Manually

To end breakout rooms and automatically return everyone to the Main
Meeting, choose Close all Rooms from the breakout panel. Participants <

will see a message telling them they are returning to the main meeting.
Returning to Main Session...

Unless this has been disabled, participants will receive a countdown Itmight take a few moments
timer, warning then to finish their discussions. If they wish to save any
documents e.g., chat, whiteboard, then they should do so now as everything will be lost when they leave
the breakout room. 30 seconds is usually sufficient countdown time.

All Breakout Rooms will close in 28 seconds Breakout rooms close automatically after: | 6 minutes

You will be returned to the main session automatically. S R N R

Return to Main Session Countdown after closing breakout room

Set countdown timer: | 30 v seconds

m Options | Recreate || AddaRod
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Chat and Private Chat V N M\onom B
There are several ways for communicating in Zoom. A participant may L”;’:L‘;"S:Eiié ety
speak into their microphone, may wave their hand towards the camera, Froe o Everyone

use the raise hand button from Reactions/Main Menu, use the emoticons |~

or they may type a comment in the chat box. The chat box allows the fine 4
addition of a social component auxiliary to the main meeting which can
help the group bond. It also permits the communication of additional,

tangential material e.g., weblinks, files and asides.

While running a meeting, it is often very difficult to keep track of an
active chat box. It can help to delegate a co-host to monito the chat or set

To: Margotand.. v [j File
some guidelines for use of the chat box. If you have trouble watching the -
ave a

chat box while leading, let participants know how they are to
communicate with you.
You can save the chat box and circulate it after the . g

. . To:  Everyone v Participant Can Chat With:
meeting, as a record of the additional comments. Zoom 7 B B
creates a folder in your computer filing system (My L Host Orily
Documents) called Zoom. In that folder you will find :

Everyone Publicly

saved chats and recordings. Do this before closing the ; . .
) - v Everyone Publicly and Privately
meeting, as the chat box is then cleared.

Private chats can also be permitted in the settings. For participants this is the equivalent of passing notes
at the back of the classroom. For the facilitator it is a way of

helping a participant that is having problems without disturbing . Zoom Group Chag
the rest of the group. -
Hello everyone welcome to the PCC Meeting for All Saints
. . . . . If you haven't picked up the Agenda for the meeting you can
To share files, e.g. a list of questions to discuss in breakout download it here:
groups, handouts of PowerPoints, meeting agendas etc., the File
button in chat can be used. This creates a downloadable file in @0 Meeting Agenda docx
the chat box. However, those on phones and tablets will not be
able to download files this way and other means such as email o
thanks
will need to be used by them.
To:  Everyone v O File
Tips for Hosts

e Sessions are often slower than when together in one room, so expect sessions to be a little longer
or cut down on the content.

e Online meetings/ services require more prior preparation so that everything is to hand and time
optimised. A pre-printed session plan can help coherence. All documents, videos etc are best open,
ready to start, and then minimised.

e Swapping to shared screens or breakout rooms all takes time and makes the session 'bitty'.
Screenshots in a PowerPoint can be more effective than real time demonstrations. Make Breakout
groups a reasonable length (at least 5 mins?) with a variety of discussion questions rather than
several shorter breakouts, where getting into the group takes longer than time in the group.

e Zoom is a visual medium and so do use the visual capacities to show pictures, videos, and files
through screenshare.

e For groups above 10 consider having a co-host to look after some, or all, of the technical side,
freeing you to lead (e.g., breakouts, screen share, chat boxes, spotlighting).
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Settings
Settings created at Scheduling

Many Settings need to be set before the meeting is scheduled. Changing settings affects only meetings
scheduled after the change. These settings can only be changed in your online account and not through
the app or desktop programme. Settings can be changed in Personal and in Admin sections. For the most
part there is little difference between these sections for a free or Pro Licence, where the admin and the
host are one and the same. If you have paid for several hosts then Admin Settings will apply to all hosts,

and personal settings apply only to you.

Choose Personal Settings for Meetings, Recording and Telephone and work your way down the list. NB if
the Licence is shared with other people, then your changes will affect their meetings too.

Settings that you may particularly wish to set here include:
Meeting Settings
Security:
e Passwords and passcodes are changed here.
e Waiting Room settings are enabled here.
e Authentication settings (can be ignored)
Schedule Meeting
e Sets the defaults for scheduled meetings e.g.,

Change whether people enter the meeting with
video and audio on or off, can enter before host etc.

In Meeting (Basic)
e Allow or disallow chat or private chat, allow file
transfer through chat, set auto save for chat

e Enable co-hosts, polls, non-verbal feedback

zool l l SOLUTIONS ~ PLANS&PRICING ~ CONTACT SALES
Important Notice Starting July 19th, 2020, all meetings must have either a Waiting Room or Passcode enable]
EERSONAL Meeting Recording Telephone
Profile
Mestings Security Security
Schedule Meeting
Webinars Require a pas:
In Meeting (Basic) 2 ‘ )
Recordings / s
In Meeting (Advanced) I
Personal Mee
Settings "

Email Notification

Other Require a pas:

ADMIN
A random pas:

> User Management neeting
> Room Management )
Require pass!

> Account Management

> Advanced

Require a pas:

e Allow screen-sharing, remote control of other screens, annotations, whiteboard, reactions

e Show Zoom windows - this will allow people to see your zoom windows (Zoom within Zoom).
Otherwise, your Zoom app will appear as a black box when screen sharing.

e Allow participants to rename themselves, view or hide their profile pictures

e Allow removed participants to rejoin.
In Meeting (Advanced)

e Breakout Rooms

e Closed captions (subtitles for hard of hearing) https://support.zoom.us/hc/en-

us/articles/207279736-Getting-started-with-closed-captioning

e Allow Virtual Backgrounds and filters

e Allow live streaming of meetings and audio and sound settings for participants.

e Request permission to unmute people
Email Notifications

e Generate automatic messages when changes are made to a scheduled meeting, but this is only for
the host unless participants have been entered into the Zoom account lists.

Other
e Set language for emails
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Recording Settings

The next tab 'Recording' has various settings
to control the way you record a session. You
may like to:

e Enable/disable participants recording
the meeting for themselves

e Set how screensharing is recorded

e Add date stamps

e Enable participants to download a
cloud recording

Telephone Settings

pamN

PERSONAL
Profile
Meetings
Webinars

Recordings
[

ADMIN

> User Management

> Room Management
Account Management

Advanced

Meeting @ Telephone
Recording

Local recording D

Allow hosts and participants to record the meeting to a local file

@ Hosts can give participants the permission to record locally

Cloud recording D
nd save the meeting / webinar in the cloud

@ Record active speaker with shared screen

Record gallery view with shared screen (3)

Record active speaker, gallery view and shared screen separately
@ Record an audio only file

@ Save chat messages from the meeting / webinar

Global Dial-in Countries/Regions
Click the Edit icon t

participants who r

these locations ap

United Kingdom |7|

The third tab, 'Telephone' lets you set
options for those who wish to
telephone into the meeting on a
landline. The most important setting
here is the final one which enables you
to change the telephone numbers
from USA to UK.

Telephone numbers are not available for the free app and you will be told that you need to upgrade.

Admin Settings

Having set the Personal Settings, you may want to look at the Admin Settings:

User Management Settings only apply if you have bought a second licence on the account.

Room Management Settings only apply if you have set up a physical space with wired in Zoom facilities.
This is done by dedicated training premises and is unlikely to be relevant to you.

Account Management deals with your Zoom Licence Account giving your profile, billing, and other details.
The Account Settings Tab repeats much of what you will find in Personal Settings and will only need to be
reset here if you have more than one host. Additional items that can be set here include:

e Password/ Passcode requirements (numeric, use of special characters etc.)

e Calendar integration enabled

e Additional virtual background pictures can be added (not everyone will see these)

e Further cloud recording settings

e Set the UK Telephone numbers that will appear in the invite.

Recording Management lets you see cloud recordings. You may need to delete recordings if your cloud

space becomes full.

Reports gives various reports about the use of the Zoom account — number of participants, number of

meetings, length of meetings etc.
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Changing Settings during a Meeting Select a Camera

v Webcam C110

Some settings can be altered during a Meeting if needed. Many of these
settings are located under Stop Video> Video Settings. Others are on the Choose Virtual Ba
Participant's Panel (see above) Choose Video Filter...

Video Settin

The following are the key options:

|_J Start Zoom when | start Windows

Video When closed, minimize window to the notification area instead of the task bar

o=y ; () Use dual monitors
2" Audio = o

() Enter full screen automatically when starting or joining a meeting

Share Screen =~ . W——— :
|_J Automatically copy invite link once the meeting starts

O Chat Always show meeting controls (@)
Ask me to confirm when | leave a meeting
Background & Filters

() Show my connected time

Recording () Remindme 5 minutes before my upcoming meetings

Profile |28 Stop my video and audio when my display is off or screen saver begins

. () Integrate Zoom with Outlook (D
Statistics

Reaction Skin Tone

Feedback / / ‘ ‘ ‘
LE LE

Keyboard Shortcuts

Accessibility

General

Share Screen
O Chat

Background & Filters

Recording
| Profile
— Camera
@ Statistics Integrated Camera v

() original ratio HD

O Feedback

My Video
Keyboard Shortcuts

() Mirror my video
ry - —
Accessibility () Touch up my appearance

Adjust for low light | Auto v

Always display participant names on their video

() Turn off my video when joining meeting

:1 Always show video preview dialog when joining a video meeting
() Hide non-video participants
() See myself as the active speaker while speaking

Maximum participants displayed per screen in Gallery View:

Did not see any video, trouble shooting

| Advanced |
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General
Speaker

Video

Output Level:

Volume:

e Profile
0 Statistics
O Feedback

Keyboard Shortcuts

o Auto

| Test Speaker

(1) Use separate audio device to play ringtone simultaneously

O Chat Microphone
\‘ Test Mic

@ Background & Filters ————————————=
Input Level:

@ Recording Volume:

Automatically adjust microphone volume

Suppress background noise Learn more

D Low (faint background noises)
C Medium (computer fan, pen taps)

(O High (typing, dog barks)

Speaker/HP (Realtek High Definition Audio) v

E @ L D)

Microphone Array (Realtek High Definition Audio) N3

E S )

Accessibility

Music and Professional Audio
Show in-meeting option to “Turn On Original Sound” (?)

Enable these options when original sound is on
High fidelity music mode (?)

Echo cancellation (3
Stereo audio (?)

Ringtones | Default

Automatically join audio by computer when joining a meeting
() Mute my microphone when joining a meeting
Press and hold SPACE key to temporarily unmute yourself

Sync buttons on headset

) ®

I2) Settings
General
Local Recording

Video

Audio

Share Screen

@ Virtual Background

@® Recording
0 Statistics

0 Feedback

Location: |C:\Users\Elizabeth Harper\Docur| | Open || Change |

66 GB remaining.

L:W Choose a location for recorded files when the meeting ends
(:J Record a separate audio file for each participant who speaks
() Optimize for 3rd party video editor ()

() Add a timestamp to the recording (@

Record video during screen sharing

() Place video next to the shared screen in the recording

() Keep temporary recording files (®

BW Leading Zoom Handbook 2021v2.doc 37

11/03/2021




) Settings
General

Video
@ Audio

B3 Share Screen
o Chat

@ Background & Filters

Recording

Keyboard Shortcuts

Accessibility

Window size when screen sharing:
\'\, Fullscreen mode
Scale to fit shared content to Zoom window
() Enable the remote control of all applications
Side-by-side mode @

Silence system notifications when sharing desktop

Share applications
Q© Sshare individual window

() Share all windows from an application

When | share my screen in a meeting
() Automatically share desktop (D

© Sshow all sharing options

When | share directly to a Zoom Room
© Automatically share desktop (D

() show all sharing options

| Advanced |

O Maximize window C

) Maintain current size

) Settings
General
Enable Global
Video Description Shortcut Shortcut
i Navigate Among Zoom Popup Windows F6 O
Share Screen Change Focus to Zgom Meeting Controls Ctrl+Alt+Shift
(On Top when Sharing Screen)
Virtual Background i ) i - ‘
View the Previous Page of Video Participants i O .
" in Gallery View gt
Recording
. View the Next Page of Video Participants in P DEWi @
0 Statistics Gallery View 9 J
Feedback Always Show Meeting Controls Alt
B Keyboard Shortcuts
Switch to Speaker View Alt+F1 O
Accessibility
Switch to Gallery View Alt+F2 O
Close Current Window Alt+F4
Start/Stop Video Alt+V O
Mute/Unmute Mv Audio Alt+A M

/\ Shortcut used by another application

| Restore Defaults |
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Troubleshooting

Audio and Video Problems

Using video links will increase the toll on everyone's internet bandwidth. Zoom is optimised so that most
people even with rural bandwidth should be able to participate easily in the meeting. However, if someone
keeps falling out of the meeting or has a jerky picture or time lag on the sound then check the following:

e Is anyone else in their home currently online? Firstly, stop any live streaming on computers or TV. If
necessary, stop any other internet use. NB Smart phones and tablets may be using the internet in

the background and might need to have internet turned off

e |f problems persist, the person could try turning off their video so that their webcam no longer

broadcasts their picture.

e Exiting and coming back in after making these changes may help.

e Deleting and reinstalling the Zoom app can help, if problems persist.

Further Help

Zoom has a wealth of help videos and tutorials. Their screenshots are sometimes a little dated, not
accounting for the latest upgrades, but usually this is not a problem.

https://support.zoom.us/hc/en-us

ZOOIM relp

Popular Topics

N A MEETING
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